
Slide 2: What is a Computer?
The most basic definition of the term computer is “someone or something that computes”. Well, that doesn’t help us much, does it?
Let’s check the Oxford dictionary definitions: a computer is “(1) an electronic device for storing and processing data, according to instructions given to it in a variable program or (2) a non-electronic device that assists in making calculations”.
The two Oxford definitions seemingly contradict each other: one refers to “an electronic device”, and the other mentions “a non-electronic device.” Why? Because these definitions are based on the history of computers, or what we consider to be computers.

Slide 3: The Evolution of Computers
Now, because we don't have an exact definition of what a computer is, zeroing in on the first computer ever built poses a problem.
	Non-electronic Computers

	Abacus
	An ancient tool for counting that uses wood or stone beads in rows. Origin – Mesopotamia, Egypt, China

	Slide Rule
	A tool with two sliding rulers, used to calculate multiplication and division and more advanced calculations.

	Punch Card
	A card with holes representing data such as records for the census or for payroll.

	Calculating Machine
	A mechanical version of the calculator.


Early “computers” were non-electronic, and assisted us in making calculations. These included the abacus and the slide rule.
The next evolution was still non-electronic, but allowed for primitive “programming”. These mechanical calculating machines belong somewhere midway between our two definitions.
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	The History of the Personal Computer video

	Explore the history of the personal computer using an interactive timeline.




Finally, in the 1940s, electronic computers made their first appearance.
ENIAC (Electronic Numerical Integrator And Computer): The first computer, built by the U.S. Army, which was the size of an entire room!
The first binary computers (Konrad Zuse’s Z3 and the ENIAC by the U.S. Army) were both developed in the 1940s, yet they bear little resemblance to today’s computers.
 

Slide 4: Computers Today
Today, one can find computers in the home, the office, and even in the palm of your hand!
[image: Desktops]
A desktop computer is a modular, stationary computer comprised of a system unit, keyboard, monitor, and mouse.
We already know what a desktop PC is the big machine that sits on a desk. Desktop PCs must have to be plugged into the wall. You can’t carry them around easily. You certainly can’t take one on a plane unless you purchase an extra seat! (We’ll examine the advantages and disadvantages of desktops and laptops a little later.)
 
[image: notebooks]



A laptop computer (also known as a notebook or portable) is a small portable computer that runs on a rechargeable battery (they can also be plugged in).
Advances in LCDs (Liquid Crystal Displays) made it possible to develop small, flat monitors, and so laptops were born. Laptops have become a very convenient way to use computers in conferences, while traveling, or at school. You can always take your laptop if you go to your friend’s house to do homework, or you can take your laptop with you when you go on a trip and watch a movie on the plane. You can even bring your laptop to give presentations in class or at work.
Laptop computers are compact, but contain everything that a desktop contains (except smaller in size). This usually means that a comparable laptop is more expensive than a desktop computer.


Slide 5: Computers Today (cont'd)
Computers now come in various sizes and types to solve all kinds of problems. In general, they can be categorized according to their cost, size, storage capacity, number of users and processing speed.
	The three most common categories are:
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Mainframes
	In the 1940s, the first general-purpose computer to be developed was amainframe. Mainframe computers can be used by many people at the same time and can handle very complex problems or large volume jobs. Mainframes are generally used for data processing for business and scientific applications.
For example, major banks can process bills for credit card holders all over the world with the aid of a mainframe. Large research projects also use the mainframe’s vast memory, storage capacity, and super-fast processing speed to conduct tests and co-ordinate operations.

	[image: minicomputer]
Minicomputers
	The minicomputer was introduced in 1963. It is a scaled-down version of the mainframe computer. It is capable of performing many jobs that old mainframe computers accomplished in the past. Due to its cost-effectiveness, the minicomputer’s most important contribution has been the introduction of distributed computing, where a number of small computers can be used instead of one giant computer.
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Microcomputers
	Two major events led to the introduction of the first microcomputer: the development of the first microprocessor in 1969 and the creation of the first general-purpose microprocessor chip in 1971. Microcomputers had a major economic impact due to their small size and drastically improved cost-effectiveness.
These powerful yet easy-to-operate machines have been called home computers, laptop computers, notepad computers, personal computers (PCs), palmtop computers and micros. The microcomputer can perform jobs that were previously only handled by the largest computers.


There is a fourth less well-known category that is often forgotten, although we see and use this type of computer every day. This category consists of the most common computers in the world: embedded computers.


Slide 6: 
[image: embedded computer]
 
Embedded computers are found within other devices and often perform only one (or a few) function(s). Their most common function is to control the operations of the machine in which they are embedded. An embedded computer is a microprocessor designed to operate within another tool. For example, computers are embedded in digital watches, refrigerators, microwave ovens, stereo systems, automobiles, and many other items.


Slide 7:
[image: computer purpose]
Computers today may seem quite complex, and using them a complicated operation, but ultimately just about everything we use them for can be summed up in four major operations:
· Inputting data or gathering data (information)
· Processing data (perform calculations and manipulate the information)
· Storing data (information) to be used later
· Outputting data (information), or display it in some way
This, in fact, becomes our definition of a computer, which is not too far off from the first Oxford definition we looked at.


Slide 8: Why Should Computers Matter to You?
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Now that we know what a computer is, why should we care? Why should computers matter to you?
First and foremost, the computer has allowed us to make advances in many important fields, including:
· Medicine (MRI, testing analysis)
· Government and military (fingerprints, tracking)
· Aeronautics (NASA satellites)
· Information handling (databases)
· Engineering (cars, planes, subways, architecture)
· Communications (world alerts)
· And many more


Future progress in these and other fields would be impossible without computers. They are here to stay in one form or another.
Furthermore, computers are spreading. They have more and more of an impact on our everyday lives, from business to entertainment. This is especially true of embedded computers, which affect so many of our daily activities.
Finally, most jobs today require some knowledge of computers and their use, especially Personal Computers (desktops and laptops). The following sections will focus on personal computers and elaborate on why they matter.
Ultimately, computers are meant to make life easier for us, and this course will help you to understand why.


Slide 9: What is a Personal Computer?
What makes a computer personal? Here are some characteristics that distinguish personal computers from other computers.
	A personal computer is interactive and ‘useful’
If you press a key or click the mouse, a personal computer will respond by performing a task. The tasks that a personal computer can perform are directly useful to you. In effect, the PC is an extension of you. Although it may not help you actually think faster, it will answer questions for you, store information, and manage your time and records. By helping you get organized, it cuts through the normal clutter of the workday and helps you streamline what you do.

	A personal computer is dedicated and ‘user-friendly’
The PC only responds to you, its owner, the ‘end-user’, without the need for a ‘computer operator’. Graphic operating systems, online help, standard commands, and enlightened programmers have made personal computers easy to use.

	A personal computer is co-operative
A PC is connected and communicative. It is connected to other computers through a network and you can communicate with people around the world in many fascinating ways using the Internet.

	A personal computer is accessible
The two most important developments in computing are arguably the microprocessor and the microchip. They combined to greatly reduce the size and price of computers and led to the rise of personal computers.
· Small size = access to a computer when you need it.
It is either on your desk at work, in your bedroom, tucked into a corner of your home office, in your kid's bedroom, or even in your pocket! No more room-sized computers.
· Low price = you can afford one.
What was once extremely expensive and rare to find in a home is now affordable and found in many homes.


Ultimately, a personal computer (PC) is defined by how it is used.


Slide 10: The Purpose of a Personal Computer
A personal computer is used to perform operations which range from work to leisure activities.
	What can I do with a computer?

	· Write and print homework
· Research
· Entertainment
· Listen to music
· Watch movies
· Play games
· Create photos, drawings, and print them
· Program applications
· Create and design websites
	· Communicate with other people around the world
· Chatting, microphone, webcam
· E-mail
· Social networking (Linkedin, Facebook, MySpace)
· Stay informed
· News sites and other references
· Buy and sell just about anything from just about anywhere


It is quite obvious that we use personal computers for numerous personal reasons, but what about when it comes to a career? How important are personal computers then?


Slide 11: Computers in Your Career
There are very few careers out there that are not impacted directly by personal computers, and a great many are completely dependent on PCs.
	Careers

	Computer Engineering
· Programmer/Analyst
· Computer Architect
· System Engineer
	Architecture
· Landscape Architect
· City Planner

	Medicine
· Technician (MRI)
· Researcher
	Arts and Entertainment
· Music
· Producer
· Distributor
· Performer
· Movies and TV
· Screenplay/scriptwriter
· Editor
· Graphics designer
· Games
· Programmer
· Graphics designer

	Education
· Teacher
	

	Business and Marketing
· Web Designer
· IT Specialist
· Graphic Artist
· Day Trader
· Financial Analyst
· Accountant
	


This is merely a sample of careers that now depend significantly on PCs! It is easy to see why computers matter to you.


Slide 12: Computer Subsystems
A system is made up of a number of subsystems that work together to perform a function. In fact, we ourselves are just a conglomeration of subsystems. We are surrounded by systems and subsystems.
· The human body is made up of the circulatory system, the digestive system, the nervous system and so on.
· An automobile has an exhaust system, an electrical system, an ignition system and so on.
[image: subsystems]
A Personal Computer is also made up of subsystems. The three main subsystems in a computer are:
· Input/Output (IO)
· Central Processing
· Storage
All of these must work together to process information.
· First, information is entered into the computer via the input part of the IO subsystem.
· Next, the information is processed by the processing subsystem.
· Finally, it can be sent to the storage subsystems and/or the output part of the IO subsystem.
· The physical devices that make up these subsystems are also known as computer hardware. Let’s take a closer look.

Slide 13: Computer Hardware
Computer hardware can usually be divided into the system unit and the peripherals.
· The system Unit (often called the Tower or Case), can be referred to as the ‘computer’. It contains the central processor and main storage subsystems, each made up of various hardware (motherboard, CPU, CD/DVD drives, hard drive, power supply).
· A peripheral is hardware that connects to the system unit. Peripherals usually make up theInput/Output subsystem (devices such as monitors, printers, keyboards, and so on), but can include external storage devices.

Slide 14: System Unit
 
[image: system unit]
The System Unit contains processing hardware, storage hardware and hardware which controls peripherals (I/O and Storage).
		System Unit Contents

	· The Motherboard houses the following:
· The CPU (Central Processing Unit)
· RAM Memory
· Control Circuitry or Buses
	· Hard Drive – Main Storage (ROM Memory)
· Other Controllers – Cards
· Data/Disk Drives – DVD/CD
· Power Supply



		[image: video]
	Video: Virtual Computer Tour

	Explore how all the parts fit inside a computer.





 


Slide 15: Motherboard
At the centre of every computer system is the motherboard. The motherboard houses the computer's microprocessor, computer memory, and most of the computer's control circuitry (paths). Control circuitry paths allow the different peripherals, the motherboard, and the CPU communicate. They are also known as buses.
[image: motherboard]
The motherboard is the central nervous system of the computer. First, it receives electrical signals from a peripheral input device, such as a keyboard or mouse. Then it processes the electronic signals. And finally, to produce output, it sends the processed signals to a peripheral output device, such as a printer or a display screen.

Slide 16: RAM Memory
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Random Access Memory (RAM) is directly connected to the motherboard. This is fast-acting memory that is erased when the power is turned off. This type of memory is also known as volatile memory. The CPU uses this memory to temporarily store the programs that are currently running. The contents of this memory are temporary and undergo constant change.
	Increase Your PC Performance

	 To increase the amount of RAM memory in your PC, you can buy extra memory chips and insert them into the motherboard.


Memory is also referred to as primary storage. Of course, data, program instructions, and the results of processing can be retained on media such as CDs and DVDs. These devices are known as secondary storage.
The most important thing that you must remember about RAM is that it is volatile, and that as soon as you turn the power off, the data stored in RAM will be lost. If the power connecting to the computer fails, RAM is completely erased. Whatever you were working on would have to be loaded again.

Slide 17: Processor
[image: processor]
The Central Processing Unit (CPU) is often thought of as the brain of the computer and is responsible for interpreting and carrying out instructions. Central processing units condense all the computational functions of a computer into just two parts: the processor and memory.
A processor is a single integrated chip that is plugged into a socket located on the motherboard. A personal computer usually has only one processor, though dual processor systems are becoming more common.
The processor's speed is measured in Mega- orGigahertz (MHz or GHz). This varies in different models, so some processors are more powerful than others. MHz and GHz are units of measurement based on the Hertz measure of frequency. MHz and GHz are 106 and 109 Hertz, respectively.
Instructions that the CPU must interpret and carry out are written in binary code, or machine language which the processor understands.
 

Slide 18: More on Memory
There is another type of memory called Read Only Memory (ROM). ROM is a form of non-volatile memory, so it is typically used to store programs and data needed for the operation of the computer system. The data stored in the ROM chip is permanently encoded at the factory, and as such can never be erased or changed. Unless you are building computers, you do not have access to ROM. The hard drive (which we’ll see later) is also ROM memory, but you DO have access to this.
The basic unit of memory is a byte. One byte is eight bits (Binary digit). A bit can have a value of 0 or 1. In other words, a byte is a combination of eight ones and zeros.
	How Much is a Byte?

	Name
	Abbreviation
	Number of Bytes
	Relative Size

	Byte
	B
	1 byte
	Can hold one character of data.

	Kilobyte
	KB
	1,024 bytes
	Can hold 1,024 characters or about half of a double-spaced typewritten page.

	Megabyte
	MB
	1,048,576 bytes
	A floppy disk holds approximately 1.4 MB of data, or approximately 768 pages of typed text.

	Gigabye
	GB
	1,073,741,824 bytes
	Approximately 786,432 pages of text. Since 500 sheets of paper is approximately 5 cm, this represents a stack of paper about 80 meters high.

	Terabyte
	TB
	1,099,511,627,766 byes
	This represents a stack of typewritten pages almost 82 km high.

	Petabyte
	PB
	1,125,899,906,842,624
	The stack of pages is now about 84,000 km high, or about one-fourth the distance from the earth to the moon.



	Saving Your Data

	Since RAM is volatile, it will be lost if there is a power surge. One way to avoid this is by using a power bar with surge protection.
However, a power bar will not protect your files from an electrical blackout. One way to protect your system is by using an Uninterrupted Power Supply between your computer and the power outlet on the wall. If power is lost, the UPS can save all the files and system status.


Memory capacities in computers today are typically measured in megabytes (MB), millions of bytes, or gigabytes (GB), billions of bytes.
What is most important to retain is that there are two types of computer memory calledRandom Access Memory (RAM) and Read Only Memory (ROM). The main distinction between the two is that RAM is a form of volatile memory used for temporary general-purpose storage, while ROM is permanently encoded.


Slide 19: More on Memory (cont'd)
Cache Memory
Cache memory is found between the processor and the RAM. It speeds up the location and retrieval of data. Cache is much faster but also much more expensive than RAM. However, RAM and hard drives are too slow to provide data to the processor without stalling calculations. So when a processor needs certain information, it first looks in the cache to check if that piece of data has been recently loaded. If the processor cannot find the information, it will then proceed to the RAM and finally to the hard drive. Retrieving data from the RAM or the cache makes computers cheaper (time-wise) because it uses small quantities of expensive and fast memory (cache) to compensate for a cheaper but slower memory (hard drive).
Virtual Memory
Virtual memory is actually a file on the hard disk. Windows and other operating systems require very large amounts of memory to run multiple programs, but RAM only provides part of this memory. In a single-processor computer, only one program runs at a time and it must use RAM. Even though RAM may contain other idle programs and their data (i.e., programs that are minimized to the taskbar but are still open), portions of the programs that cannot fit into RAM are stored on the hard disk as virtual memory.

Slide 20: Logical Memory Organization
Memory handling is determined by the microprocessor. Recent computers have this memory structure:
 
[image: memory structure]
Although it may consist of the same kind of chips, not all memory in a PC works in the same way. Some programs are restricted to using only a fraction of the available capacity and some memory is off-limits to all programs.
Although the memory repetition in this structure seems redundant, it makes use of the RAM and cache memory as depositories of recently accessed information. This helps to make computers faster by reducing the distance that data has to travel to go from the hard drive to the processor.
 

Slide 21: Buses and Device Controllers
 
 
[image: bus]
The processor, under control of a computer program, uses its control/communication operations to direct the flow of data into and out of memory. It also coordinates arithmetic and logic operations. To perform these operations, instructions and related data are sent along wires or buses.
Buses can either be internal or external. They are the paths (circuitry) that connect the CPU with internal and external components. The bus speed along with the processor speed influence how fast a computer will operate.
A device controller is a set of chips or a circuit that operates a particular device such as a printer, disk drive, or mouse.
Buses include:
· PCI and PCI-E slots, which allow connection of graphics cards
· PS/2 ports, which allow the connecting of keyboard or mouse
· Universal Serial Bus (USB), which allows the connection of various peripherals

Slide 22: Hard Disk Drive
[image: hard disk in system unit]
 
A hard disk is a non-volatile storage device made of rigid aluminium platters that have been coated with a magnetic material. It is usually stored within the system unit, and is sealed airtight. You cannot see it except for the disk drive light. The read/write head does not actually touch the hard disk surface, but floats over it.

Slide 23: Hard Disk Drive (cont'd)
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	Video: Hard Disk
Anatomy Interactive

	Explore how a hard disk reads and writes data.






The hard drive has a very high storage capacity (many Gigabytes) and most of your applications are stored on it, including Microsoft Office and Internet Explorer.
 

Slide 24: Controllers and Cards
These devices or cards connect to the Motherboard via buses. They usually include:
Video Display Controller
	Note

	The most common brands for graphics cards are:
NVIDIA
ATI
Intel
Matrox
You can browse their websites for product information if needed. Or ask any salesperson in a computer store to advise you according to your graphics needs.


This is often called the graphics card, or the graphics accelerator. The graphics card generates and outputs images to display. There are two types of Display controllers: an expansion card is a separate piece of hardware that plugs into a slot on the motherboard, while integrated graphics are actually part of the motherboard.
Various graphics cards may have different functions and allow you to connect your computer to a TV, or to capture video, as well as to connect to multiple monitors. Advanced graphics cards (for gaming, computer graphics applications, programming, etc.) can be quite expensive.
Expansion graphics cards have their own dedicated memory which is used to process images and may have its own dedicated microprocessor called a Graphics Processing Unit (GPU). Integrated graphics accelerators may use the computer’s RAM.
Sound Card
The sound card allows for the input and output of audio signals. Like the graphics card, the sound card can be integrated or expansion. An expansion card will plug into a slot on the motherboard.

Much like graphics cards, sound cards can have many different functions. Basic cards will allow input through a microphone and output through speakers. More advanced cards may interface directly with musical instruments.
Network Card
The network card is also know as a LAN (Local Area Network) Adapter and allows the computer to connect to a network. This is how computers communicate with each other and with the Internet. Network cards can be integrated or expansion type.

Slide 25: CD & DVD Drives
Data, or Disk Drives, are hardware that allows the computer access to external storage media. Basically, this means that you can store data outside the hard drive and carry it around with you. There are two types of optical disk drives: CD and DVD.
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	Video: CD and DVD Reading and Writing interactive

	Explore the history of the personal computer using an interactive timeline.


CD Drive
Everything used to be stored magnetically (magnetic cassettes and cartridges). Now everything is stored optically. You will not find tapes in computers anymore, or even find floppy drives (small disks known as the A: drive). Actually, even CD-R and DVD-R drives are becoming less popular because technology has advanced enough for CD-RWs and DVD-RWs to be available on all new computers.
DVD Drive
Today, DVD drives are quite common in personal computers. Like CDs, DVD media include DVD-R (recordable) and DVD-RW (rewriteable). Some DVD drives enable you to use CD-R, CD-RW, DVD-R, and DVD-RW disks.
 

Slide 26: Peripherals
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	Video:
Port Tour: How Do I Hook It Up?

	Explore various computer ports such as USB ports, FireWire, Ethernet ports and a few others.


Enough with what’s inside a personal computer. Let’s take a look at the hardware we can connect to a computer.
Peripherals can mostly be separated into Input and Output hardware. Peripherals connect to the computer (system unit) via ports.
Peripherals connect to PCs in a variety of ways. The most common include the serial port, the PS/2 port, the USB (Universal Serial Bus) port or wireless electronic communicator. Serial ports are used mainly for monitors as well as the printer. Most other devices are now connected with USB ports. PS/2 ports are used mainly for the keyboard and mouse, but are being phased out with advances in USB ports.

Slide 27: Input Devices
What is an input device?
Input devices are the means by which you enter information into your PC, that is, the primary means by which you interact with your personal computer. The various devices available span an entire range of technologies, from the tactile to the vocal. Although they work in different ways, they all accomplish the same task: they enable you to communicate with your computer. Input devices convert the mechanical into the electronic form that your PC can understand.

What are the basic input devices you can use with a personal computer?

	Desktop
	Laptop

	Keyboard
	Built-in Keyboard

	Mouse
	Built-in Touchpad or Other Pointing Device



Are there any other input devices that you can add?
Yes. You can always plug in a scanner, webcam, microphone or printer.

Slide 28: Output Devices
What is an output device?
An output device is hardware that sends data out of a computer. The most common output device is the monitor (or LCD display). And the most common output device that you buy for a computer is the printer. 
What can you add as an output device?
· Another monitor or LCD display
· Printer
· Speakers
· Sound and video output for TV

Slide 29: Monitor
 
[image: Monitors]
A monitor (or video display unit) displays a temporary output. Output used for reference does not have to be printed on paper. Temporary output is especially useful to display information that changes rapidly. For example, in airports, screens display up-to-the-minute flight information, while at a football game scoreboards provide temporary output reflecting current scores and statistics.
The points of light are called picture elements, or pixels for short. If you look closely at your display screen, you will see that each character is made up of tiny points. The size and number of points displayed on a screen determine the screen's sharpness, or resolution.
CRT and LCD are two common types of monitors. The monitor on the left is a CRT. The monitor on the right is a LCD.

Slide 30: Monitor (cont'd)
CRT Monitor
The CRT is very much like an ordinary television screen, but instead of a television picture tube, it uses acathode ray tube (CRT). Images are created on a CRT by an electron beam that scans across a phosphor-coated surface, leaving points of light.
LCD Monitor
Flat screens are more compact and now come with all new computers. Flat screens employ a liquid crystal display (LCD) in which fluorescent light is used to light up liquid crystals and align them in a predetermined configuration, creating output characters.
 
[image: Pixels]
	Tip

	Be careful with LCD displays so that you do not scratch or ruin the coat on them. Broken or burnt-out pixels cannot be repaired.


 
 

Slide 31: Printer
Of all the external peripherals people attach to their PCs, the most popular is undoubtedly the printer. Little wonder, considering that the printer is the primary means of converting your computer's intangible information into the hard copy of the material world. Printers use a variety of technologies to put your data on paper, and each has its own advantages and disadvantages.
There are several printers available to consumers today. You can distinguish between machines by their quality, speed, technology, purpose, weight, color, or any other of their innumerable (and properly pragmatic) design elements.
Printers: Did You Know?
Affordable laser printers are faster, but lower-priced models lack color capability. 

Color inkjets provide multiple hues, moderate speed, and lower costs, but lack the capability to create high quality, smooth, detailed drawings. In the final analysis, your choice will be dictated by your needs.
Similar to scanners, the quality of a printer is usually measured in dpi (dots per inch). The more dots per inch a printer can output, the sharper the image will be.
Combination printer, fax, scan, and copy machines are offered by various brands, but they are expensive. There are also few reviews of these combination machines because they are new to the market. Take a look at the buying guide for more information on places to shop for them.
A photo printer creates images of photos and by using photo-style paper and gloss, the document has the exact feel of a photo. Photo printers now have USB ports and memory card slots so that you can transfer images from either a digital camera or your USB key to the printer directly (without having a computer at all) and print them right away.
 

Slide 32: Storage Devices

	Storage Media Capabilities

	 
	STORAGE MEDIUM
	CAPABILITIES
	STORAGE CAPACITY

	
	Hard Drive
	Read and write
	External: Up to 2 TB (Terabyte)
Internal: Up to 750 GB

	
	CD
CD-RW
	Read-only
Read and write
	700 MB

	
	DVD
DVD+RW
	Read-only
Read and write
	4.7 GB (for single-sided, single-layered DVDs)
9.4 GB (for single-sided, dual-layered DVDs)

	
	Blu-ray (BD)
	Read and write
	27 GB (for single-layer discs)
50 GB (for dual-layer discs)

	
	Flash Memory Cards
	Read and write
	16 MB to 8 GB

	
	Flash Drive
	Read and write
	Up to 12 GB



Blu-ray (BD-ROM, BD-Writer) is the next generation in data drives. It is a high-density optical disk which can store up to 50 Gigabytes of data (about 10 times more than a DVD). They are often used for high-definition video.
Flash memory card is a form of portable storage. This removable memory card is often used in digital cameras, MP3 players, and personal digital assistants (PDAs).









Slide 2: What is the Internet?
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	Video: Welcome to the 
Web

	Look at a number of interesting websites that you may not be familiar with.


The Internet is a large network of computer networks. It uses electronic communication to connect computers across the world so that they can share information. The Internet (and the name itself) comes from the idea ofinterconnected networks. So, no one really owns the Internet and no one really manages the Internet.
In 1958, the United States Department of Defense commissioned the development of a network of computers that could withstand nuclear attack. At this time, it was envisioned as a defense mechanism that would allow military communications to continue if normal communication lines were broken. Fast-forward to today, and realize that the Internet is a vast network comprised of computers that can communicate worldwide. 
	ARPA

	The Internet was created in 1969 and based on research by the Advanced Research Projects Agency (ARPA), a branch of the U.S. Department of Defense. Later, it was developed into a broader network by a number of additional research projects.



The Internet is a way to stay connected with relatives or friends virtually anywhere in the world. It is also a way to search for information or research facts.
This Internet map displays all the networks that are interconnected with each other. The map keeps growing as our technology advances and more and more people and networks connect to the Internet.

Slide 3: What is the Internet? (cont'd) 
[image: internet]
The World Wide Web (known as WWW or the Web) is a part of the Internet. HyperText Transfer Protocol (HTTP) is a set of rules that dictates how Web pages are formated and transmitted across the Web. A Web server is a computer that stores Web pages, has server software installed, is connected to the Internet and transmits data when requested.
A website is a collection of web pages. Websites are designed to display pages that include text, graphics, animation, sound, movies and links to other pages. The unique address for each Web page and Web resource is a Uniform Resource Locator (URL). A domain is the name for the resources that make up a website. For example, www.econcordia.com is a domain. HyperText Markup Language (HTML) is a programming language used to create Web pages.
The Web became a part of the Internet in 1989. The number of pages available on the Web are numbered in the billions.

Slide 4: The Evolution of the Internet
[image: evolution internet]
* Information gathered from www.internetworldstats.com.

Slide 5: Recent Internet Advances
The Internet has seen huge advances since the first two computers were remotely linked. Now, you can even have normal video and audio conversations with friends and relatives around the world. You can watch movies and play games, and you can search for information on any topic you can think of. Stay up to date by reading the most recent news, watching the most recent videos and listening to radio webcasts. The Internet alerts you to events happening around the world, right up to the minute!
		Connect with friends and relatives using various 
Internet services, such as:

	· Chat (MSN, YIM, etc.)
· E-mail (Hotmail, Yahoo, Gmail, etc.)
· Audio Conference (Skype, MSN, Yahoo, etc.)
· Video and Audio (Skype, MSN, Yahoo, etc.)
· Blogs and social sites (Facebook, MySpace, etc.)



		Research information

	· Research newspapers and journals
· Research thousands of libraries online
· Gather online publications
· Gather upcoming online information






Slide 6: Internet = Interconnected Networks
Now we know that the Internet consists of numerous networks that are all connected. But what exactly is a network?
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	Video: Installing a Computer Network

	Learn about what hardware and software components you need for home networking.


· Networks are two or more connected computers, plus the various peripheral devices that are attached to them.
· Each object connected to a network, whether it is a computer or a peripheral device, is known as a node.
· Networks allow the computers to communicate and ultimately share information and resources.

Network Adapters
Each node (device or computer) in a network must have a network adapter. This is a device that allows the node to communicate with other nodes. They can be external (plugged into a USB port), but are usually internal and in the form of a Network Interface Card (NIC), which fits into an expansion slot on a computer’s motherboard.

	Connections between nodes:

	· Telephone wire (twisted pair cable)
· Coaxial cable
· Fiber-optic cable
· Wireless



	Networks allow you to:

	· Share peripherals (printers, scanners, and so on)
· Transfer information directly (without using external storage media such as CDs and flash drives)
· Centralize information and reduce redundancy
· Connect to the Internet


 
 
 

Slide 7: Internet Connections 
	[image: video]
	Video: Connecting to the Internet

	Explore various ways you can connect to the Internet.



There are various way to connect to the Internet. A dial-up connection has a low transfer rate which means it has a slow connection. High-speed Intenet connections are also called broadband. Broadband options include DSL (Digital Subscriber Line), cableand satellite.

	Internet Connections

	Dial-Up Modem
	Up to 56 Kbps (Kilobytes per second) transfer rate

	DSL (Digital Subscriber Line) Modem
	Up to 1.5 Mbps (Megabytes per second)

	Cable Modem
	Variable transfer rate

	Fiber Optic Internet
	Up to 30 Mbps



Modems
Modems are devices that allow your computer, which is digital, to understand analog signals coming through your phone line.
Routers and Switches
Routers handle the transfer of data from network to network. For instance, they are essential when connecting your home network to the Internet.
Switches work within a network. These devices make sure that data is transferred to the correct network node.

Slide 8: Topology
	Topology

	[image: topology]

	Topology
	The physical shape of a network.

	Bus or Linear
	All nodes are connected in sequence on a single cable. Typical P2P network.

	Ring
	Nodes are connected in a circle.

	Star
	Each node connects to a central switch which re-transmits the data in the right direction.



Slide 9: Networks
We know that the Internet is a huge network, but there are smaller networks that you may be familiar with. Networks can be differentiated by their size, their hierarchy and their topology. Ethernet is a specific network protocol that allows nodes to connect to each other. It is the standard for P2P networks.
		Network Size
(distance between nodes)

	LANs
(Local Area Network)
	Connects computers reasonably close together, as in the home, school computer lab or small office settings.

	WANs
(Wide Area Networks)
	Multiple LANs connected. Connects computers over a larger geographic area, as in businesses or universities.

	MANs (Metropolitan Area Networks)
	Connects specific area networks, such as cities.



		Network Hierarchy

	Peer-to-Peer 
(or P2P) Network
	Every node in the network can communicate directly with every other node. Most home networks are this type.

	Client-Server Network
	The ‘Server’ computer acts like the central administrator for functions available to the ‘Client’ computers (such as printing). The Internet is a Client-Server network.






Slide 10: Network Components
[image: network components]

Slide 11: Internet Service Providers
We now know what a network is, that the Internet is a large network, and what hardware we need to connect to this network. Is there anything else we need to know? Yes.
Internet Service Providers (ISP) are companies that provide Internet services to people. There are many companies in Canada, but major providers include:
· Bell (Sympatico)
· Videotron (in Quebec only)
· Rogers (rare in Quebec)
· Many other smaller companies
If you want to connect to the Internet at home, you will have to contact one of these companies either in person or by phone. They will set up your connection (using cables, a modem, and/or a router) to the Internet using their network.
The various ISP companies all have package plans that offer different Internet connection speeds (Dial-up, DSL, cable, and so on) and features. The speeds and features available often depend on where you live, and the choice you make will depend on how you intend to use the Internet. A lot of files uploading and downloading (especially music and video) will require higher speed (transfer rate).

Slide 12: What about Wireless Networks?
Wireless networks are becoming more and more popular. This is especially due to the increasing popularity of laptops and other portable devices. Wireless networks do not require your computer to be physically plugged into the Internet modem. Wireless networks use routers and a wireless network adapter (today, this is built in to all laptops).
Wireless networks work in the same way as regular wired networks except that once you connect to the Internet, your adapter connects to the router which in turn connects to an ISP. 802.11 standard is a method of communication used on wireless networks. 
Hotspot
A hotspot is a place that has wireless access to the Internet. The most popular hotspots are airports, hotels, cafes, restaurants, libraries, bookstores and schools.
Most hotspots are not secure. This means that anybody can access them and therefore your computer may be vulnerable. Some hotspots have authentication enabled, meaning that you have to enter a username and password to access them. Most hotels, schools and libraries have this authentication and provide you with a username and password when asked.

Slide 13: How Does it all Work?
We now have all the information we need. Let’s turn to an example of how you connect your computer to the Internet.
Let’s say you want to browse the following Web page: www.google.com.
What you need:
· A connection to the Internet using some sort of hardware (a modem or network card). A router will allow more than one computer to connect.
· An Internet browser such as Internet Explorer, Mozilla Firefox, or another browser (see later section). This software allows you to surf the Internet.
 
[image: internet connection]
1. Once you have typed the address of the site you are looking for (Google) into your browser, your Modem (or Router) will connect to your Internet Service Provider (ISP) and send an Internet Protocol (IP) address. Each Web page has a unique IP address.
1. Your ISP will send the IP to Google’s network server (a series of computers that store all their data).
1. Google will then send an IP packet (a series of IPs pointing to various Web pages and information) back to the ISP. In essence, this means that they are sending back the Web page you have requested.
1. Your ISP will send the IP packet to your modem (or router), and your Web browser will display the information. All of this usually happens in less than a few seconds (depending on your access speed)!

Slide 14: What is a Browser?
	What is a Hyperlink?

	A hyperlink is a reference (usually displayed in a different font, color, style or underlined) such as:www.econcordia.com. It “links” or references another document, Web page or website. A website usually has many hyperlinks that link all the Web pages together.
Example:
A personal website will usually have a home page that welcomes the audience to the website (and displays any upcoming news or events). Other pages such as a portfolio or ‘About Me’ page are accessed through hyperlinks. 
Usually your mouse cursor (an arrow) will change to a hand icon when moved across a hyperlink.


A browser is an application that allows you to locate, view and navigate Web pages. There are several Web browsers available, but the most commonly used are Internet Explorer, Mozilla Firefox, Safari and Opera. Most Web browsers have extra features that allow you to set up your favorite websites, your home page and your privacy settings. Computers that you buy in a store usually come with Windows Vista (operating system) andInternet Explorer 7. Internet Explorer 7 now has Tabs. It allows you to view many websites in the same window. Different browsers can be downloaded from their developer sites, but most computers come with at least one browser already installed. Web browsers enable you to navigate the Web by clicking on hyperlinks.

Slide 15: Evolution of Browsers
Browsers have had quite an extensive history of competition and still do. Netscape was the first major player in the browser game. It made its start in the early 1990s. Opera followed soon afterwards. 
[image: evolution of browsers]

Slide 16: Evolution of Browsers (cont'd)
The most popular browsers currently in use are Internet Explorer and Mozilla Firefox. The table below lists some common browsers and some similarities and differences which may influence your preference. 
	 
	Internet Explorer
	Mozilla Firefox
	Opera
	Safari

	Features
	Optimized for Windows Operating System (since it’s owned by Microsoft).
IE’s latest version uses tabs to differentiate between different websites all in one window.
IE has small issues with security.
IE has features for bookmarking favorite websites. It also gives you options to change privacy settings and trusted vs. non-trusted websites.
 
	Firefox is open source and works on all platforms. It is owned by the public GNU license and components can be added to it, unlike IE.
Firefox has better security features and is widely considered to have more protection.
The 2001 version of Firefox has tabs and allows user to bookmark favorite sites and to set up options for privacy.
Open source allows for add-ons (features).
 
	Opera was an early player in the Web browser game. It has returned to the market and is growing fast.
It was the first browser to have tabbed windows (2000).
It works on all platforms.
Opera is ery popular on cell phones because it uses shortcuts and has all of the same features as IE and Firefox.
It is c onsidered highly secure, like Firefox.
 
 
 
	Safari was the first Web browser made specifically for the Mac computer.
It is the default browser that comes with a Mac as well as with iPods and iPhones (and most other i-devices).
Safari can also be used on the Windows platform.
 
 
 
 
 
 
 

	Website
	Internet Explorer
	Firefox
	Opera
	Safari


Choosing a browser is a matter of personal preference. Some people choose a browser based purely on its appearance. Others will take into consideration the features and usability. Try them all out and visit their websites for more information.
Remember, these are the most common browsers, but there are many more out there.















Slide 2: What is Software?
The most basic definition of software is “a set of instructions that tell a computer what to do”. These instructions are also known as programs. Software is essential if a computer is to be useful to anyone other than a skilled programmer.
Software is different from computer hardware. It does not need any physical connection to the computer. There is no need for cables, jacks or connectors. Ultimately, software is just data - files (instructions) that are in computer memory and are executed upon command.
Some examples of software are Microsoft Office (Word, Excel, etc.), Internet Explorer, Windows Live Messenger, Notepad, Paint, Adobe Photoshop, Solitaire, even Windows Vista and Windows XP. Basically, anything that allows you to do anything on the computer is software.
There are many different types of software, but generally they are categorized in one of the following groups:
· System Software (Operating System)
· Programming Software (Computer Science and Engineering)
· Application Software (User)

Slide 3: Types of Software

	Type
	Description
	Example

	System Software
	System software actually interfaces with the hardware. It allows the computer’s hardware to work with application software and in turn work for you.
This category is mostly made up of Operating System software. Operating systems make working with a computer much easier. They help you use the computer and avoid typing computer code and they have user-friendly interfaces (mouse, keyboard, icons, etc.). Without these systems we would be stuck typing programming or machine language in order to get anything done. Operating system software does most of this work for you. Not only does it make the computer’s inner workings easier to handle, it also gives you faster performance by categorizing everything in human terms. It also manages all your files for you.
Other software, such as drivers (software you need to download so that your hardware works correctly) and utility programs (disk deframgmenter, disk clean-up, etc.) are also in this category.
	Windows Vista
Windows XP
Mac OS X
Linux

	Programming Software
	Programming software is used mainly by programmers and computer scientists. This type of software allows programmers to create other software. This software includes compilers, editors, interpreters, debuggers, and more. We won’t focus on these, but you should know that they exist. Programmers use different languages such as Java, C++, or PHP to use these tools.
	Visual Studio
Eclipse 
MySQL

	Application Software
	This is the software you will use the most. This includes utility programs, word-processing programs, spreadsheet software, digital image-editing, games, workplace-specific software, databases, medical software, business software, and more.
	Microsoft Word, Excel, PowerPoint, Access
Solitaire, Frogger, Call of Duty, Adobe PhotoShop, FrameMaker, InDesign
Windows Media Player, RealPlayer, iTunes


 

Slide 4: How Does Software Work?
Let’s keep things simple. After all, this isn’t a computer science or software engineering course.
When the operating system boots up, it organizes the storage and all of the files for you. When you use a computer for any task, your instructions (keyboard typing, mouse click) are interpreted by the operating system. What we think of as simple tasks are considerably complicated for computers to translate, but in the end, the computer performs them much faster than we could. The simple act of entering text and printing a sheet requires long lines of programming code.
For example, imagine that you simply want to start Microsoft Word. That’s a system task in itself (even moving the mouse is a task).
1. Click on the Microsoft Word icon or shortcut.
2. The CPU processes the instruction and activates the Microsoft Word executable file (in memory). This starts the Word program.
3. The Operating System interprets this as “input” and sends the instruction to the computer’s CPU (brain). It also saves this action.
4. Now you are able to use the program, which interprets your keystrokes and displays the letters you type.


The previous example was a very simplified example of a basic action. Just imagine what goes on in your computer when you ask it to save, copy, paste, play videos, and so on.
In essence, what computer software does is interpret your actions when using input devices in order to hopefully do something useful.
The operating system, therefore, is the interface in between you and the CPU. It receives your input and saves it in storage while the CPU carries your instructions out. The CPU reads all these actions as machine code (a very low-level computer language). Today, CPUs are extremely fast. The second you click on a software icon, the software activates.
Application software does the same thing, but the tasks it lets you perform can be much more specific, such as display the letter ‘T’, or play this exact music file, or load this web page.

Slide 5: What is an Operating System?
Essentially, an Operating System (OS) is a complex program that manages all of the system files used by your computer. It manages the flow of data in your computer. 
[image: OS functions]
OS Functions:
· Allow the user to interact with the computer
· Manage the CPU
· Manage memory and storage
· Manage system hardware and peripherals
· Manage applications software and memory allocation (coordination)


Which OS you install on your computer depends on a number of factors. Will you be using it at home or at the office? What level of security do you need? Is your computer a PC (IBM or clone) or a Macintosh? For the purposes of this course, we will look at Windows.
 

Slide 6: What Happens When You Turn on the Computer?
[image: boot_process]
When you turn on your computer, a process called bootstrapping starts up and loads the operating system into memory (such as Windows XP, Windows Vista, Mac OS, etc.) Most operating systems are stored on the hard disk.
Often when you turn on the computer you see a black screen with gray or white writing running down the page very quickly. Nowadays this only lasts for a couple of seconds before you see the Windows splash-page. Once upon a time, computers had no operating systems and users worked in that black screen.
After your operating system loads you are in control of the computer. You can sign in or begin opening applications.

	Reboot

	When you reboot (or restart) your computer, you are restarting this bootstrapping process. If this is done correctly (‘Soft’ or ‘Warm’ reboot - click start and then click restart) then the computer will save all of your data at that time. If you reboot your system through the power button (also known as a ‘Hard’ or ‘Cold’ reboot - not recommended ), then you can lose data easily because you are abruptly stopping the process without any warning.



Slide 7: What does the Operating System do?
As mentioned in the previous section, the operating system is the interface that helps you communicate with the computer. It displays all the software and hardware that you have access to in terms that you can understand. It translates the computer’s languages (machine code and programming languages) into a language you can understand.
The OS does this by displaying a Graphical User Interface (GUI). This system is the one that lets you use the mouse and keyboard for your desired actions. It also includes the icons displayed on the desktop.
Evolution of OS interfaces:
· Command Line Interface
· Type commands to communicate
· Very complicated for most users
· Menu-driven Interface
· Select tasks from a list displayed on the screen
· Still not easy enough for most people
· Graphical User Interface
· Graphics and point-and-click technology


The Operating System also allows you to manage your files by creating hierarchies of folders and files within drives. This lets you store your data in an organized and efficient way.
The OS also multi-tasks different programs so that it seems like the computer is doing more than one or two things at a time. It allows you to have many programs running at once (depending on how much memory the computer has). What is really happening is that the OS manages how the CPU handles all of these tasks so that it is constantly busy completing different tasks for different programs.

Slide 8: Types of Operating Systems
	Name
	Description

	Windows XP 
Windows Vista 
[by Microsoft]
	Microsoft Windows dominates the operating system world market share.
It is based on MS-DOS which was a Command Line OS created in the 1980s.
Later versions of Windows used…windows. It is simple enough so that any user is able to use a computer without having to know commands.
Windows XP and Windows Vista are the most common operating systems for PCs today, in homes almost all libraries, schools and businesses.

	Mac OS X [by Apple]
	Mac OS X runs on Mac computers. Because the Mac market share has increased in recent years, so has the popularity of Mac OS X. Mac OS was the first OS to have a GUI (1984).
In general, Macs are used less in schools and businesses, but are popular with artists and students in non-science programs.
Mac OS X has a completely different navigation system than the Windows systems, and Leopard (the latest version) is based on the Unix operating system.

	Ubuntu [by Linux]
	Ubuntu is currently the most popular of all Linux-based operating systems.
Linux is mostly used by computer science professionals and companies specializing in computers.
It is a stable and more efficient OS, but it is more difficult to use than Windows.
Linux is an open source OS, which means that it is freely available and can be modified by users as they wish.


 

Slide 9: Windows
Windows is the most used operating system in the world. It was developed by Microsoft and derives its name from the on-screen "windows" that it uses to display information.
A window is an area of the screen that the Operating System sets aside for a specific task. You can run several programs at the same time, each in its own window. You can choose to have one program's window occupy the entire screen to display as much information as possible, or you can display all of the windows simultaneously. Each window can also be hidden in the background while you work with one program in the foreground.
If you buy a brand new PC today, it will almost surely be equipped with Windows Vista, the latest version of the Microsoft operating system. Older versions that you might encounter include Windows 95, Windows 98, and Windows XP. Many handheld devices also run an adapted version of Windows (such as Windows XP Tablet).

Slide 10: Application Software
[image: Application categories]
Application software is software that you use on a daily basis to do most tasks on your computer. Unlike Operating System software, you have some control over these programs (at least when and if they are run). Application software makes it possible for you to use your computer for work or for entertainment.
	Application software is usually organized into different categories:
	Some popular application software:

	· Utility Programs
· Productivity Software
· Multimedia Software
· Entertainment Software or Learning and Leisure
	· Microsoft Office (Word, Excel, PowerPoint, Access, FrontPage, Outlook, Visio, etc.)
· Windows Media Player, Real Player, VLC Player, iTunes, etc.
· Internet Explorer, Mozilla Firefox, Safari, Opera, etc.
· Calculator, Notepad, Paint, Solitaire, etc.
· Adobe Photoshop, InDesign, FrameMaker, Reader, Illustrator, etc.
· Many more


If you want to write an essay, or plan your budget, you may need to use different types of software in combination. For example, writing an essay would require word processing software (such as Microsoft Word or WordPad) and perhaps a Web browser (like Internet Explorer or Firefox) or reference software (such as Encarta) to do your research. There are an infinite number of tasks that you can do with the various application software available.

Slide 11: Utility Programs
Utility programs are application software that help you maintain and manage your computer’s software and hardware. Most of these programs have very specific functions and can help your computer run more efficiently.
Some examples of utility programs are Winzip (a file compression program), Disk Defragmenter (a system utility), and even the computer Calculator or Volume Control (accessory programs).
Utility software can:
· Let you alter how your computer’s desktop (screen) looks
· Help you manage (add or remove) other application software
· Compress files (make them smaller) for easier storage or transfer
· Help you carry out regular system maintenance
· Let you schedule maintenance tasks so that they are done automatically
· And much more


The following utility programs are very useful when it comes to maintaining your computer’s performance.

Disk Cleanup
Disk Cleanup cleans unnecessary files from your hard drive. These are mostly files in the Recycle Bin and Temporary files created by your Operating System or temporary Internet files.
The Disk Cleanup program is found in the System Tools folder within the Accessories folder of the Start menu. When you run Disk Cleanup, it calculates how much hard drive space might be gained by deleting certain files, and it then lets you choose which files (if any) you would like to erase.
You should perform a Disk Cleanup fairly regularly (once per month) depending on how much you use your computer.
Disk Defragmenter
Because your computer does not necessarily store related information in the same areas of the hard disk, over time, locating the scattered pieces of a file may take more time (it takes longer to open a file). Disk Defragmenter tries to regroup related data so that your operating system works more efficiently.
Disk Defragmenter is found in the System Tools folder within the Accessories folder of the Start menu. It has an analyze feature which will tell you whether or not defragmenting your hard drive is necessary.

Slide 12: 


[image: applications]

Productivity Software
Productivity software helps you complete tasks or create documents for school or work. Usually these documents can be output (to a printer).
The most popular Productivity programs are probably those in Microsoft Office. They include Word (a text processor), Excel (spreadsheet for numerical calculations or tables), PowerPoint (for presentations), Access (database software), and Outlook (Personal Information Manager and e-mail).
Open Office is a free software package that is quickly becoming very popular. It offers a suite of programs similar to those in Microsoft Office:www.openoffice.org.

Slide 13: Multimedia Software
Multimedia software is a diverse category of software that enables you to create, organize and edit music (audio), movies (video) and pictures (image).
While actually viewing or playing files with this software is usually quite easy, editing multimedia files (videos, music or images) usually requires more advanced knowledge of the programs. Many of these programs have online tutorials that can help you learn how to use them, and forums where other users may be able to answer your questions. They are usually supportive of beginners.
Multimedia software is closely related to entertainment (leisure) software, since most programs used to edit or create media such as music or video can also play those media files.
	[image: video]
	Video: Enhancing Photos with
Image-Editing Software

	Learn tips and tricks on how to best use image software to enhance digital photographs.



	Photo-editing Software
	Video-editing Software
	Audio-editing Software

	· Microsoft Photo Story
· Picasa
· Adobe Photoshop (any version)
· Corel Paint Shop Pro
	· Adobe Premiere
· Microsoft Movie Maker
· Blender
	· Audacity
· Sony Sound Forge
· Adobe Soundbooth



Slide 14: Learning and Leisure
Learning and Leisure (or Education and Entertainment) software is a very broad category of applications. There are an almost endless number of programs out there that either let you relax and enjoy yourself or help you buckle down and learn something new.
Learning software is usually subject-based, but general reference software is also available. While much learning software is geared toward younger computer users, there is a lot to choose from for adults. Language software is very popular and can help you learn just about any language you can think of. You can even find software that will teach you to cook or to use a computer. Various test preparation software can also be found (SAT, MCAT, etc.).
Reference software has replaced those bulky books that no one ever read. Encyclopedias, dictionaries, even atlases are now available as software. These reference applications are much easier to use than their paper counterparts, especially since they offer search and cross-reference functions. Just remember to cite them as your sources!
Leisure (entertainment) software is everywhere! It includes games and applications to let you listen to music and movies, or even programs to let you draw.
When you buy a computer, it usually comes with software to play media files (music, video) and a few games. Most media files are viewed or played with the default application that is installed on your computer. For example, when you want to listen to a sound file (a song), clicking on that song might start Windows Media Player, clicking on a picture file (a photo or drawing), might start Adobe Photoshop or Windows PictureViewer.
The computer games industry is huge. Billions of dollars are spent in development and thousands of new titles are released every year, so there is a good chance that you will find something you like. The industry has come a long way since Pac-Man, so make sure your computer is powerful enough to run the application. Most titles display their system requirements, making this simple to do.

Slide 15: Acquiring Software
When you buy your computer, there are usually a number of programs already installed, including the Operating System, some simple games, some other media software, and often some productivity applications. Most other software products that you might want will need to be purchased separately.
There are two ways to buy software - in a retail store or online. Online orders usually add shipping charges, so they may be more expensive (and there will be a delay before the orders are delivered). Nevertheless, many applications can now be bought online and downloaded directly to your computer. Now that is convenient.
Software can be expensive, especially professional use software (such as Photoshop), but there are some alternatives available. Some software can be used or downloaded for free.
Make sure you read and understand the copyright and licensing agreements that come with all software.
Web-Based Applications
Web-based applications are programs that are run directly from your web browser. They can include things like Mapquest (a mapping application - www.mapquest.com), or Google Docs word processor, spreadsheet, and presentation application – http://docs.google.com/), or even online tax-preparation applications. Web-based applications are usually free to use.
Freeware
This is software that is available at no cost (usually on the Internet) although it is copyrighted. There are all kinds of freeware programs just waiting to be downloaded on the web including games, screensavers and more. Just search for freeware in any browser and you will see.
Also looking for Open Source applications is a good way to find software that is free to use.  
Shareware
Shareware is software that is available for free, but with certain conditions. This may mean that the application can only be used for a short amount of time before it has to be bought, or there may be no support offered for users unless the software is registered.
Using shareware after the trial period ends breaks the licensing agreement and is illegal.

Slide 16: Installing Software
Installing software these days is very easy. First of all, most software comes with an installation guide. It will guide you through the process step-by-step.
Most software comes on a CD (or DVD). Once you insert the CD in your computer, the installation process will begin. Simply follow along. You may be asked to enter an authentication key (a number that identifies the software as a legal copy). The installation wizard (a process that helps you install software) will then guide you through the complete installation. The wizard will also allow you to customize the software according to your preferences.
Downloaded software is very simple to install. It usually requires that you simply start the executable file. This is the file that installs the software. It is identified by the .exe extension. This will start the installation wizard and the installation process.

Slide 17: Windows
Windows is a Microsoft product which allows users to control and manage the computer, software and files.
· Windows Vista
· Windows XP
· Windows XP Home Edition
· Windows XP Professional Edition
· WIndows XP Media Center Edition
Windows first hit the market in 1985. In the time between then and now, Windows has undergone many changes. The most recent versions of Microsoft Windows are Windows Vista and Windows XP. Vista was released for general use in the early part of 2007. Windows XP was released in 2001. Windows XP will continue to be used by people who are satisfied with its performance.

Slide 18: Windows (cont'd)
 
	Windows Vista/Windows XP

	Versions
	Description
	Windows XP Comparable Version

	Windows Vista Home Basic
	This version is for low-level, budget home users who do not require advanced media support.
	Windows XP Home Edition

	Windows Vista Home Premium
	This version combines the media features of Window XP Media Center Edition with the Windows XP Home Edition to support advanced home media uses such as HDTV and DVD authoring.
	Windows XP Home Edition with features from Window XP Media Center Edition

	Windows Vista Business
	As its name implies, this version is aimed at the business market. Similar to Windows XP Professional, this version has added support for networking capabilities. This product comes bundled with a new version of Internet Information Services (IIS), one of the most widely used web servers for corporate websites.
	Windows XP Professional

	Windows Vista Enterprise
	This edition is aimed at the enterprise segment of the business market and is not available through retail stores or OEMs (Original Equipment Manufacturers). It comes with Microsoft Virtual PC, which enables it to run on any platform, and has a multilingual user interface.
	 

	Windows Vista Ultimate
	This is the "ultimate" operating system for high-end PC users, gamers, multimedia professionals, and PC enthusiasts. Vista Ultimate comes with RSS (Really Simple Syndication) support for easy access to podcasts and weblogs, a game performance tweaker, DVD ripping capabilities, and other online capabilities for downloading media.
	 



Slide 19: Windows Desktop Components
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Windows is built around an office analogy. You will be able to see this in the identifying terms used. We begin with the Desktop. Everything takes place on the Desktop. You can arrange documents and folders on the Windows Desktop just as you can on the one in your office. Icons are used to represent the objects on the Desktop. The Desktop shown here contains icons for the Recycle Bin, the Internet Explorer, the Microsoft Media Player, Spy Sweeper software and a Projects Folder. Your Desktop probably contains different objects. You can add and delete objects from the desktop. Each of the objects on the desktop has specific properties.
The Taskbar contains a number of tools that you can use to load software programs and gain information about your computer. The buttons on the Taskbar will change based on what is happening in your computer.
The Start button is used to start programs and other functions. A keyboard shortcut is the Windows button. Pressing this key brings up the Start menu. This menu will be discussed in the next slide.
The Quick Launch toolbar shows program icons. Clicking on an icon in this area will cause the program to load. This Quick Launch toolbar shows an icon for America Online and the Internet Explorer. Your computer may have different programs on the Quick Launch toolbar.
The Desktop Search button helps you find things on your computer. It might not be installed on your computer. If so, it will not be visible. It is a feature that is installed with Office 2007.
The Notification area shows some of the programs that are running in the background memory of your computer. Since these are tiny icons, you will find it helpful to hover your mouse pointer over the icons. This action will cause Tool Tips to appear so you can see what the program is. In this area you will find tools for volume control, network connections, Windows updates, and a button that allows you to safely remove a flash drive from the USB port.
The Clock displays the time. If you hold the mouse pointer over the clock, the day of the week and the date appear.

Slide 20: Start Menu
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The Start menu opens when you click on the Start button. There are two columns on the Start menu. Pinned items are programs that are used often and selected to be included in this area for fast access. You can change the settings to pin the most important programs to you in this location on the menu. The recently used programs appear below the pinned items. In the case of the menu shown here, we can see that the Internet Explorer is used most often, followed by iTunes. To see a full list of available programs, click on the All Programs button.
The right column of the Start menu contains Windows folders that you will access often along with options for searching, help and the Control Panel. The All Programs button will cause this menu to be hidden behind a listing of software programs installed on your computer. If you decide you wish to use the hidden menu rather than the program menu, click in the blank space above the All Programs button.

Slide 21: Using Windows
 
[image: using windows]
Windows are rectangles on the Desktop that display programs or folders currently in use. The operating system is a multitasking system that allows multiple windows to be open at the same time.  This slide shows Microsoft Word, Microsoft Excel, the Internet Explorer and a solitaire game running on the Desktop. The Internet Explorer is the active window because the bar at the top (called the title bar) is deep blue colored and the menu items are darker. The other programs have dimmed title bars. Only one window can be active at a time. Switching between the windows is as easy as clicking the one you wish to activate. Notice the taskbar shows four programs running. Another way to bring one to the front is to simply click on the button on the taskbar.

Slide 22: Move and Size a Window
 
[image: move size window]

One of the great things about Windows is that you can change the size and position of the open windows on the screen. To resize a window, point to any border and drag the border inwards or outwards as you desire. You may also drag a corner to change the height and width of the window simultaneously. To move the window, click and drag the title bar to the position you desire. 

Slide 23: The My Computer Window
 
[image: my computer window]

The My Computer window gives you access to devices, such as disk drives and folders. A task pane displayed on the left allows you to initiate systems tasks and navigate to another place on the computer. Notice that the My Documents folder is in the Other Places pane. This is very helpful because this folder is the default for storing all Microsoft Office files.
This window also shows a menu bar. The menus are somewhat consistent between all Microsoft products. You will normally see File, Edit, View and Help menus in open windows. Other menu options may appear that are specific to the software program running in the window. When you click on a menu item, a drop-down menu with selections appears.
The Toolbar, directly under the menu, contains buttons for manipulating objects in the window. Note that you can barely make out the Back button. This is because this function is not available. In this case, this window was opened directly and there is no “back” to go to. In contrast are the Up button, the Search button, the Folders button and the Views button. They are all available on this window.

Slide 24: Scroll Bars and Status Bar
 
[image: scroll status bars]
Often the window cannot display everything available. When this happens, scroll bars appear either on the side, bottom, or both. The additional contents of the window can be viewed by clicking repeatedly on the arrows at the ends of the status bar to move the window in small steps. You may also want to move the slider bar by dragging it with the mouse pointer for a faster scroll. You can also click on the open part of the bar to advance the window one window at a time.
The status bar gives you information on the contents of the window. In this window, you can see that there are 21 objects available. The files listed in this window take up approximately 2.75 megabytes of storage.

Slide 25: Using Display Menu
 
[image: using display menu]
Menus display commands that are available in the application program. When you click on a menu, a drop-down menu appears. A shortcut is to press the Alt key and the underlined letter on the menu you wish to open. For instance, if you wanted to open the Edit menu, you would press Alt E. Once you have opened the menu, you may select a command by clicking on it, or by using the Alt key and the underlined letter for the command.
Ghosted commands that are dimmed on the menu mean that they are not available at the time. Usually you forgot to select something before opening the menu when you see ghosted commands. Cut, Copy and Paste are currently unavailable on the Edit menu shown.
In the next slide we will discuss the different menu appearances.

Slide 26: Menu Components
 
[image: menu components]
On the File menu, notice the word Open, followed by an ellipsis. This indicates that additional information will be needed to execute the command. A dialog box will open when the command contains an ellipsis. You will make setting selections in this box and usually click the OK button to proceed.
A check next to a command, as you see for the Status Bar, is a toggle switch. This command can either be on or off. A check indicates that is it on.
The bullet next to Tiles indicates that this setting is selected from a group of settings. In this menu, there could be a bullet next to Thumbnails, Tiles, Icons, List or Details. Note that the gray lines separate these options from the rest of the menu. Only one bullet point can be marked in a group at any one time.
An arrow after a command, as you see here on Toolbars, Explorer Bar, Arrange Icons and Go To, indicates that a submenu will appear when this command is selected. You will be able to choose commands from this cascaded menu.

Slide 27: Dialog Box Components
[image: dialog box components]
Dialog boxes open when additional information is needed to complete the command sequence. You will remember from the last slide that an ellipsis indicates that a dialog box will open when that command is selected. In this case, the Print command was selected.
Different settings have different selection methods. A drop-down arrow, when clicked, will display options. In this case, it would be the names of the printers available to the computer. You would select one by clicking on it.
The check boxes are again toggles, representing off or on. There can be more than one check box selected. So in the Print menu, you could check both the Print to File option and the Manual Duplex boxes.
The spin button is where you can select an option by clicking up or down. Often these are used for selecting a number. In this case, you can select the number of copies you wish to print.
The option buttons are in a group. With option buttons you can only select one option at a time. That option is indicated by a darkened button. Sometimes option buttons are called radio buttons.
The text box allows you to type information. The only text box on the Print dialog box is to list the page numbers you wish to have printed. In this case, as soon as you start to type in the text box, the option button for Pages will turn on.
Some dialog box selections will cause yet more dialog boxes to open. Note the Options button with an ellipsis as an example of this, as well as the Find Another button.
The command button selection tells the computer to accept the settings you have made and run the command, or cancel the command. All dialog boxes contain at least two buttons, one for accepting the selections and one for canceling them.

Slide 28: Help and Support Center


[image: help support center]

Windows and all Microsoft products offer many ways to get help. The Help and Support Center is available by clicking on the Start button and selecting Help and Support. When using this help menu, you will be able to request information from other Windows XP users and access the Microsoft Knowledge base on the Microsoft website. You may search for specific data using the Search text box.  For general information, select a Help topic. If you are trying to complete a certain task, like updating your Windows software, select from the Pick a Task list.

Slide 29: Keyword Search


[image: keyword search]

A more complete list of help topics is available by using the Index button and typing in a search term. In this dialog box, you will see that “mouse” has been typed in .
If you find yourself going to the same topic many times, you can save it by clicking on the Favorites button. This way you will not have to remember the keyword you used to find the topic. This topic will be saved for reference and available by just clicking on the Favorites button and selecting the topic.
The History button shows all of the help topics visited during the current help session. This is helpful because you might read a topic and jump to another, only to realize that the answer was on the first topic you read. Using History can get you back to topics you have visited quickly.

Slide 30: Files and Folders
	File
	Folder

	File – a collection of data
· Program file - part of a software program
· Data file - a file created with a program file
· File name - identifies a file
	Folder - holds multiple files
· Can also hold other folders



	[image: video]
	Video: File Management

	Learn about organizing the files saved in your computer by creating folders.


Knowing the difference between files and folders is important for Windows users. A file is a set of instructions or data that has been given a name and stored in a storage location on the computer. In a similar fashion, folders are named and stored on the computer. The storage location can be the hard drive of the computer, flash drive, or even a CD. 
 

Slide 31: Files and Folders (cont'd)
Program files are software applications that help you to complete tasks such as word processing or crunching numbers in a spreadsheet. The files you create with the software applications are data files. This might be a letter to your family or a budget for your department.
Every file on the computer has a name. This identifies it so that the operating system can find it. You may name files with up to 255 characters, including spaces and punctuation. There are some characters you cannot use in naming a file, so even though you can use punctuation, it is best to avoid it and use only letters, spaces and numbers. Be sure to name your files with descriptive names so that you know what they contain by looking at their names.
	Filename Extensions

	Extension
	Type of Document
	Application that Uses the Extension

	.doc
	Word-processing document
	Microsoft Word 2003

	.docx
	Word-processing document
	Microsoft Word 2007

	.wks
	Word-processing document
	Microsoft Works word processing

	.wpd
	Word-processing document
	Corel WordPerfect

	.xls
	Spreadsheet
	Microsoft Excel

	.slr
	Spreadsheet
	Microsoft Works spreadsheet

	.mdb
	Database
	Microsoft Access

	.ppt
	PowerPoint presentation
	Microsoft PowerPoint

	.pdf
	Portable Document Format
	Adobe Acrobat or Adobe Reader

	.rtf
	Text
	Any program that can read text documents

	.txt
	Text
	Any program that can read text documents

	.htm or .htlm
	Web page
	Any program that can read HyperText Markup Language

	.bmp
	Bitmap image
	Microsoft Paint

	.zip
	Compressed file
	Winzip


 

Slide 32: Files and Folders (cont'd)
Folders, just like folders in your file cabinet or on your desk, hold files. Just as you use folders in real life, the folders in the computer help you arrange documents so you can find them again. There can be thousands of files on a computer and it is important that your work be accessible when you need it. You can create and maintain folders on all types of storage devices.
Certain folders are automatically created by the operating system. The best known folders are the My Documents and My Computer. Software applications that you add to your computer often add folders to the system. Even though there are folders doing their work on the computer, it is a good idea for you to make decisions about what personal folders to create and where to store them. For instance, some students make a folder for every class they take on their flash drive. Other students might make a folder for projects they are completing. Still others might keep folders based on quarters or semesters. When you are employed, your employer may have rules for how files are named and stored in folders.

Slide 33: Working with Folders
 
[image: working with folders]

In this slide, you can see folders on the left. They are designated by a file folder icon. Look closely at the Homework folder, which is open and the file folder icon is actually shown as open! On the right side of this window, you can see two data file icons in a tiled view. Notice that the documents have icons on them that represent the software that was used to create them. The one on the left is an Excel spreadsheet. The one on the right is a PowerPoint presentation.

Slide 34: Creating a New Folder


[image: creating new folder]
In order to arrange your files, you will need to know how to create folders. The first step is to decide which storage device you will use for saving your folder. Open My Computer by clicking on the Start button and selecting My Computer. Storage devices have icons that look like the device. Select the storage device by clicking the device icon.
With the storage device selected, click on the File menu. Select the New command. The cascading menu will have an option to create a new Folder. Select this option. A New Folder icon will appear, ready for you to type in the folder name. After you have typed the name, press Enter.
If you ever need to change the name of a folder because you have misspelled the name or the purpose has changed, right-click on the folder name and select the option to Rename it from the shortcut menu. Key the new name and press Enter. Another way to rename a folder is to click on it and press the F2 key on the keyboard. Again you will key the folder name and press Enter.

Slide 35: Deleting a Folder
[image: deleting folder]
Just as you can create new folders, you can delete folders that you no longer need. It is important to know that if you delete a folder, you are also deleting the contents or files within that folder. To delete a folder, select the folder you wish to delete by clicking on it. Right-click and select Delete. You will be prompted to make sure you really wish to delete the folder. Click on Yes and the folder will be deleted.
Folders and files deleted from the hard drive of the computer can be recovered from the Recycle Bin. If the folder or file was deleted from any other storage device, such as a flash drive or CD, the work cannot be recovered. More information on this concept will be covered later in this lesson.

Slide 36: Folder Views


[image: folder views]

Folders can be viewed in various ways. Previous slides showed the folder list in Tile view. This slide shows the folder list in List view. Other options are Icons, Tiles, Details and Thumbnails or Filmstrip, if you have photographs in the folder. To change the view of the folder, click on the Views button on the toolbar and select the view you want to see.

Slide 37: Windows Explorer


[image: windows explorer]
Windows Explorer is a program that displays your folders and files in a hierarchical structure. This slide displays the contents of the E: drive, which is a flash drive, including the folders in the left pane and the files in the right pane. You can change what you will see in the panes by clicking the Folders button on the toolbar.
Some of the folders in the left pane have a plus sign to indicate that there are subfolders in the folder. If you click on the plus sign, the contents will expand so that you can select other folders. A minus sign will then appear next to the open folder. By clicking the minus sign, you will collapse the folder.

Slide 38: Moving and Copying


[image: moving copying]
Learning to manage files is very important. You need to know how to move and copy both files and folders. If you know how to move and copy files, you also know how to move and copy folders.
The easiest way to move or copy a file is to drag it from one folder to another as needed in the Windows Explorer. When you drag a file or folder to the same storage device, for example the flash drive, the file or folder will be moved. If you drag between storage devices, a copy will be made. When you move a file or folder, there will only be one copy of the file or folder on the storage device. When you copy, there will be a copy on each storage device.
If for some reason you want two files with the same name on the same storage device, press and hold the Ctrl key as you drag the file to the new location.
You may also right-click and drag the file to the location you select. When you release the mouse button, a shortcut menu will appear. Select Copy Here or Move Here from the shortcut menu as you desire.

Slide 39: Backup Strategies


[image: backup strategies]
Backup strategies are extremely important. So many things can affect your storage devices, from viruses to losing flash drives to having a hard drive crash. The best way to avoid data disaster is to have a backup copy of your work. You need to plan for it before it happens. Most people keep important data in two storage devices. You can see two different storage devices in the graphic in this slide. Both contain the same file. One is a flash drive and the other is the hard drive.
The rule of thumb for backing up data is that if it will take more time to re-create than it takes to back up, then back it up. Data is generally the only thing you have to back up because you can reinstall application software from the CD.

Slide 40: Recycle Bin
[image: recycle bin]
Tossing computer data into the trash is just as easy as tossing papers into your trash can. You can delete a file by selecting it in the My Computer or Windows Explorer and pressing the Delete key on the keyboard. You may also select it and right-click. The shortcut menu contains a Delete option. Another alternative is to drag the item into the Recycle Bin.
When you delete files from the hard drive, they really go into a storage folder called the Recycle Bin. As long as the files are in the Recycle Bin, they can be restored to their original location. Once your Recycle Bin is emptied, you will not be able to retrieve the file. The Recycle Bin works only with hard drive files. If you delete a file from a flash drive, there is no Recycle Bin and it is permanently gone when you delete it.
Just as in your office you occasionally empty the trash, you will want to do the same with the Recycle Bin. Open the Recycle Bin from My Computer or from the desktop. Click the Empty the Recycle Bin option to remove the files from your hard drive. If you only want to remove a few items permanently from your Recycle Bin, click on the items and press the Delete key or right click and select the Delete option.
But let’s say that you deleted something and you have decided you want it back. You have two options. The first is to use the Restore all items option in the Recycle Bin task pane. You may decide that you wish to restore only one or two files. Locate the files in the Recycle Bin, right-click on the file name, and select the Restore option from the shortcut menu. An alternative is to select the file and open the File menu. You will find a Restore option there too.









Slide 2: Office 2007 Applications
 
Microsoft Office 2007 is a combination of four software applications. You will select the software that is appropriate for the task you are trying to accomplish, so you should begin each project by thinking about what the output will be.
	Word
	 Document processing

	 Excel
	 Spreadsheet

	 PowerPoint
	 Presentation

	 Access
	 Database


Word is used for document processing such as letters, memos, resumes and reports. Word focuses on manipulating text to create, edit and format documents. 
Excel stores numeric data and performs calculations on this data. It can also create charts for a graphic view of the data. Spreadsheets are used to create budgets, project payments for a mortgage or loan, and to analyze statistical information.
PowerPoint is a presentation software package. Presentations can be given by speakers, they can be self-presenting like those you might see in a kiosk, or they can consist of a web page presentation.
Access is a relational database which stores data and converts it into information. It is used mainly for decision making in the business world because it is so easy to compile data into informative reports. Access will not be covered in this course.
One of the advantages of Office is that the applications work together and complex projects can be completed by integrating the applications. Another advantage is that many tasks are accomplished in exactly the same way in all of the applications. This makes them easier to learn and to use.

Slide 3: Common Interface Components
 
		· Office Button
· Office Menu
· Quick Access Toolbar
· Title Bar
· Status Bar
	· Ribbon
· Tabs
· Groups
· Commands



		[image: video]
	Video: Transition Guide to Microsoft Office 2007

	A side-by-side comparison with Office 2003 - how to perform basic tasks and use the new features shared across the Office 2007 programs.





If you have used previous versions of Office, the tools available in Office 2007 will be familiar in concept, but they may be located in different places and use different icons to represent the command. The following slides will discuss not only the similarities in the software, but also the location and concept behind the commands.
A user interface is the meeting point between the computer and the person using it. The Microsoft Office 2007 software program is the user interface. There are many commonalities between its four different applications.
The most noticeable components that are common are at the top and bottom of the software windows. The Office Button displays the Office Menu which contains the same commands in each software application. The Quick Access Toolbar provides icons for normal tasks. The title bar helps you to identify the file you are working on and the application. The Ribbon displays commands in groups on tabs. The Status Bar provides useful information about the file you are working on in the window.
Each of these interface components will be discussed in detail in the following slides.

Slide 4: Common Interface Components (cont'd) 
[image: common interface]
 
The Office Button holds the Office menu which contains commands that work on the entire file or program. Common commands on this menu include ways to save, print and share the file. You will also find options to change the properties of the software application, or to exit the application.
The Quick Access toolbar contains buttons for frequently used commands such as saving a file, undoing the last action or refreshing the screen. This toolbar keeps these commands readily available at all times. An advantage of this toolbar is that it can be customized by adding buttons or removing those that are not used. If you wish, you may also change the location of this toolbar by dragging it below the Ribbon.
The title bar lists the filename of the document and the Office 2007 application you are using. In the file shown here, the filename is Document 1, and the application is Microsoft Word. The title bar also contains the commands to minimize, maximize and close the application as it does in all Windows applications.

Slide 5: The Ribbon
[image: the ribbon]
The Ribbon holds visual commands arranged on tabs. This is the command center of the Microsoft Office 2007 software. There are three components on the Ribbon: tabs, groups and commands.
The tabs, which look like file folder tabs, are divided into task-related sections. In this graphic from PowerPoint you can see tabs for Home, Insert, Design, Animations, Slide Show, Review, View and Add-ons. The active tab is the Home tab, meaning that the commands shown are the core commands for the application program.
The core commands are grouped. These are related commands that are put together so you can find them quickly. On the Home tab, you see groups of commands for the Clipboard, Slides, Font, Paragraph, Drawing and Editing. When you click on another tab, you will see different command groups.
The Commands are the specific tasks to be performed. They are visual icons or buttons in the grouping. The icons give you a visual clue. Look at the Shapes command in the Drawing group. There are a few shapes there. Look at the Find command in the Editing group. It is a pair of binoculars for finding things!

Slide 6: The Ribbon (cont'd)
[image: the ribbon continued1]
This is the Ribbon with the Home tab displayed from Word. In Word you have different interface needs. Most often, you will be using commands that allow you to format the text and manipulate it by copying and pasting it.
Also note that the Word and PowerPoint tabs are different. The Word Ribbon contains the tabs Home, Insert, Page Layout, References, Mailing, Review and View. You will remember that the PowerPoint Ribbon contained the tabs Home, Insert, Design, Animations, Slide Show, Review, View and Add-ons. Different software have different requirements and the tabs reflect these differences.
If you do not want to see the Ribbon in any application, it can be made smaller by double-clicking on the active tab. This hides the groups and commands. When you want to display the entire Ribbon again, click the active tab.

Slide 7: The Ribbon (cont'd)
[image: the ribbon continued2]
The Ribbon also contains other components that will make your work easier. The Dialog Box Launcher is a small icon, usually an arrow, which opens a dialog box with a related group of commands.
The Gallery is a set of options that appear as thumbnail graphics to represent the results. You can see the Font Gallery with the Bold icon being bold face, the Italic icon being an italic face, and the Underscore icon being underscored.
The Live Preview works with galleries to show you a preview of how the document would look with the formatting commands applied. This saves you time, because you can instantly see if the formatting serves your needs and apply it if it does, or move to the next command if it does not. On this slide, the dark blue selected in the Theme Colors menu is showing in the corporation name. Prior to the selection of dark blue, the font color was red.
The contextual tab shows specialized commands that display only when the object they affect is selected. A selected picture produces a contextual tab with commands specifically related to the image, such as the Drawing Tools tab shown here. When you click away from the image, the contextual tab disappears.

Slide 8: Keyboard Shortcuts
[image: keyboard shortcuts]
Key Tips are numbers or letters that can be used as keyboard commands to access tabs on the Ribbon. To access the Key Tips, press the Alt key. Then press the key for the tab you wish to open. There are even Key Tips for opening the Office Button! Using Key Tips is easy because you don’t have to remember the shortcut keystrokes. If you are used to using Ctrl keystrokes from previous versions of Office, those will still work.

Slide 9: The Status Bar
[image: status bar]
The status bar provides specific information about the file on which you are working. It is located at the bottom of the window. In this PowerPoint status bar, you can see circled, the slide number, the total number of slides and the applied theme. The View commands provide quick access to the various views available for the application. A Zoom slider allows you to change the magnification of the document. Slide it to the right and the document increases in size. Slide it to the left and it decreases in size. Bear in mind that different Office 2007 applications may display different information on the status bar.

Slide 10: Office 2007 Help
[image: office 2007 help]
You are never far away from getting help when using Office 2007 and that help can be accessed in a variety of ways. There are help files on your computer that were installed as the software was installed. Microsoft Office Online offers more help files, plus access to new products and files such as templates and graphics to help you complete your projects.
Initiating help can be done by using either the Help button on the Ribbon or the keyboard F1 key. This will open a dialog box with a search option, a list of topics and the ability to view help through a table of contents.

Slide 11: Super ToolTip Help
[image: super tooltip help]
Super ToolTips are displayed when the mouse lingers over a command on the Ribbon. The Super ToolTip provides the command name, a brief description of the command and a link for additional help. If you would like even more help, hold the mouse on the command and press F1. This will take you directly to the help file for this command because Super ToolTips are context sensitive.
Information on obtaining help with dialog boxes follows on the next slide.

Slide 12: Dialog Box Help
[image: dialog box help]
Sometimes you need help in dealing with a dialog box, but you don’t want to close the dialog box to get assistance. Each dialog box contains a Help button located on the title bar for the dialog box. If you select a dialog box Help button, the help will be context sensitive and apply to the open dialog box.
This concludes our discussion of getting help in Office 2007, but it shouldn’t be the last time you use it or think of it. Whenever a question arises, be sure to check out Help first!

Slide 13: Universal Tasks
	Manipulating files
· Creating new files
· Opening files
· Saving files
· Printing files
	Manipulating documents
· Editing documents
· Formatting documents


 
Throughout Microsoft Office 2007 there are tasks that you will need to complete in all of the applications. Two broad categories of universal tasks are manipulating files and manipulating documents. We will cover each of these task groups in detail, pointing out techniques used to complete tasks.
Computers are useful because they store data in files. The data can later be retrieved and formatted into reports. Computers can hold vast amounts of data but if it is to be useful, people need to be able to easily access and re-use the data. Our discussion of manipulating files focuses on opening, saving and printing the files. In the lesson on Windows XP, techniques for using folders were discussed. That will remain important because the files should be organized in a thoughtful way on your storage devices so you can find them faster. Also discussed in the lesson on Windows XP were techniques for copying, moving and deleting files. Such techniques are accomplished by using the operating system. The techniques we will discuss in the next few slides are accomplished by using the software.

Slide 14: Creating New Files
	Software
	 Default Filename

	 Word
	 Document1

	 PowerPoint
	 Presentation1

	 Excel
	 Book1


 
Whenever you work with a software application, you either need to open an existing file or start a new file. Microsoft Office creates a new file whenever the software is started. A default name is assigned to a file until you save it and designate a name for it. The default names are listed here because sooner or later you will probably be in a hurry and save a file to the default filename. It may appear as if you have lost your file, when in reality it has been stored. You can look for these filenames when you make this kind of mistake.

Finally, you do not want to use filenames like Document1, Document2 and Document3. Filenames should be descriptive. In some business environments, you will be required to name files using a very strict set of rules so that not only can you find them, but your co-workers can too.

Slide 15: Saving a File
[image: save file]
A good practice is to save the file with the descriptive name as soon as you open the software. As you work on a complex file, it is a good idea to save different versions of it with different names as you work on it. This way if you have a problem with the most recent file, you can always open the previous file and not have to start again from scratch.

To save a file in Word, Excel or PowerPoint, click the Office Button. Two options for saving will appear on the Office menu. Save is used if you wish to save the document with the original file name. Save As is used the first time a document is saved, if you wish to change the name of the document, or as a new file type preserving the original file with its original name. This slide shows the Save As dialog box because this is a new file being saved. How can you tell? There is no data in the file and the name on the title bar is Book1.
· The first thing you should do when you are working with this dialog box is to select the location in which the file will be saved. You may select a location from the My Places Bar. In this graphic, the My Documents folder has been selected. If you wish, you may also create a new folder. Since folders provide a hierarchical storage system, you may need to move up a folder to find the correct storage location.
· The second step in saving a file is to provide a descriptive filename.
· The third step is to check the Save As type to make sure that it fits your needs. Normally the textbox contains the regular file type for the software you are using, but it can be changed to fit other needs. For instance, a Word document can be saved as a document, document with macros, template, template with macros, and in other formats such as a web page.
 
After making appropriate selections, click the Save button and the file will be stored as you specified. If you have used Office software in the past, you will be familiar with the filename extensions added by the software. With the new version, Microsoft has introduced XML formats to make use of file compression to save storage space and to make it easier to open the files with other software. The extensions now contain four characters. The extra character describes whether the file contains macros, is a template, or has other characteristics.

Slide 16: My Places Bar
[image: myplaces bar]
While in the Save As menu, you can change the My Places Bar to reflect the folders you use most often in Word, Excel and PowerPoint. Select the folder you wish to put on the bar in the Save in box. In this slide, you can see that we are using the Excel 2007 folder. Point to the empty space in the My Places Bar and right-click. From the shortcut menu select the option to Add the folder. Notice that you can remove or rename the folder from the My Places Bar as well as move it to a different location on the bar. You will only be able to manipulate the folders you put on this bar. The other folders, assigned by the software, will remain unchanged.

Slide 17: Opening a File
[image: open file]
The Open command on the Office menu to is used to access a file on a storage device, bringing it into the memory of your computer so that you can work with it. Click the Office Button to see the Office menu.

In a similar fashion to saving a file, you must find the storage location of the file. The Look in box gives you access to the hierarchical view of the structure of folders and subfolders on your computer or network by clicking on the down arrow. You may also select the location from the My Places Bar. You may change the View of the folder list, navigate up, create new folders and delete files and folders using the Look in toolbar buttons.

When you have found the file you wish to open, select it and click the Open button. This loads the file into the software application.

There are instances where you may not want to open the file, but rather open it as read-only or as a copy. This will be discussed in the next slide.

Slide 18: Open Dialog Box
[image: open dialog box]
There are situations where you might not want to open a file directly for editing. You might be a part of a workgroup that shares files. In this situation, you will need some alternatives in opening the files so that you do not damage the original file you share.

To access the Open Dialog Box, click the down arrow on the Open button. As you can see, there are a variety of options. Open loads the file for editing. Open Read-Only will not allow you to make changes to the file. Open as Copy loads a copy of the file for editing, leaving the original file intact in the storage location. Open in Browser loads the file into a Web browser. Open and Repair attempts to repair any damage to the file and open it for editing.

Slide 19: Recent Documents List
[image: recent document list]
Office 2007 provides a quick method for accessing files you have used recently through the Recent Documents list. When you click on the Office Button, the Recent Documents list appears on the right side of the menu. If a file you wish to use is on the list, simply click on it to select and open it.

As the name implies, the files in the Recent Documents list change as you use other files. If you wish to keep a file on the Recent Documents list, you may pin it to the list. Click on the gray icon of the push pin to change the color to green. This means that the file will remain on the list permanently. If you later wish to remove it from the list, click on the push pin again. The pin will change back to gray and as other files are used on the system, this one will drop from the list.

Slide 20: Previewing a Document
[image: preview document]
Hard copies of documents are needed for distribution. This might include letters, spreadsheets, handouts and other types of informational reports. Office 2007 provides many options for printing documents.

A powerful tool offered in Office is the option to preview documents prior to printing them. This saves paper and time. You can instantly see if something is not lined up correctly or if the orientation of the page is incorrect for your needs.

To access the Print Preview, click the Office Button and click on the arrow next to the Print command on the Office menu. Select the Print Preview option. The Print Preview tab becomes available with groups for making adjustments to the view or to the document. Note that in the Page Setup group, you can change the margins, orientation and size of the document. In the Zoom group, you have options to magnify the document, show it in actual size, and show multiple pages at one time. The Preview group allows you to move from one page to the next so that you can check the entire document before printing.

If you need to edit the document before printing, click the Close Print Preview button and make the necessary changes to the document. If you are satisfied with the document as it is shown, click on Print in the Print Preview tab. 

Slide 21: Print Dialog Box
[image: print dialog box]
Before exploring the Print dialog box, you should recall page orientation.
 
The orientation of the document on the page can be portrait or landscape. In the portrait orientation, the page is longer than it is wide. In landscape orientation, the page is wider than it is long. You can change the orientation of the page in the Print Preview Page Setup group.

You can access the Print dialog box from the Print Preview view, or you can select it directly from the Office menu. The Print dialog box provides many options for printing a document. Each time you print a document you should check the settings for the printer, what to print, and how to print.

The printer selection will be set to your default printer when you open this dialog box. It can be changed by clicking the down arrow in the printer name box. You would do this if you had multiple printers available and wanted to select another.

In the Print range area, you can select to print the entire document, just the current page shown in the window, or set a range of pages to be printed.

In the Print what area, the options will be different depending on the software application you are using. In the PowerPoint application, you will have options to print slides, handouts, notes or an outline. In this Word example, you will see the option of printing the document. Other choices under the down arrow include document properties, styles, markups, and more.

In the Copies area of the dialog box, you select the number of copies you wish to print using the spin box. NOTE: You may have a duplex printer which prints on both sides of the paper. If you do not have this type of printer, you can create the same effect by selecting the Manual duplex check box. The document will print all of the odd numbered pages first, then prompt you to flip the pages over and put them back in the printer tray. It will then print all of the even numbered pages.

Slide 22: Quick Printing
[image: quick printing]
You do not have to use a dialog box for printing. A Quick Print option sends the entire current file to the default printer when you select Quick Print from the Office menu or add a Print icon to your Quick Access toolbar.
To add the Print icon to your Quick Access toolbar, click on the Dialog Box Launcher of the Quick Access toolbar. Select the Quick Print option from the File menu on the left. Click the Add button in the middle. The Quick Print option then appears on the Quick Access toolbar. You can remove items from the right side by selecting the item and clicking the Remove button. You may also change the order that the icons are in on the Quick Access toolbar by clicking the up or down arrow on the right.

Slide 23: Basic Tasks
	Editing Documents
	Formatting Documents

	· Selecting
· Inserting
· Overtype
· Moving
· Copying
· Clipboard
· Finding
· Replacing
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· Repeat
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· Grammar
· Thesaurus
· Research
	· Font
· Format Painter


In the previous slides, we discussed methods for manipulating files. The following slides will focus on the basic tasks that are similar as you manipulate the document. These tasks fall into two categories: editing the document and formatting the document.
Most of us, when creating a document, make mistakes. Office 2007 offers many options for making corrections. You may add text, delete text, and move text many times during the revision stage of your writing. We will discuss these actions in the next few slides. Office also contains tools to help you make your writing more accurate. Spelling and grammar can be checked as you are creating the document or after you have completed the draft. The Thesaurus can list synonyms if you find yourself using the same words over and over. The Research tool provides you with access to an online dictionary, encyclopedia, and other reference resources.
We will conclude our discussion with information on formatting documents to change their appearance. 

Slide 24: Selecting Text 
[image: select text]
Most editing processes require that you select the text you wish to edit. This is most often done by clicking and dragging over the text with the mouse. Selected text, as shown here, appears on a blue highlighted background. A new feature of Office 2007 is the Mini toolbar, which appears automatically when you select text in Word, Excel or PowerPoint. The Mini toolbar contains commands that apply to the selected text. These commands are normally found on the Home tab, but the Mini toolbar makes it quick to select an option. Note that the icons on the toolbar mimic the icons on the Home tab.
There are additional ways to select text, as detailed on the next slide.

Slide 25: Selecting Text (Cont'd)
[image: select text continued]
You can select text by other methods that may work better based on the what you are trying to select. If you wish to select a single word, you can double-click on it with the mouse. For a whole line of text, move the pointer to the left of the line and click when the mouse pointer changes to a right-pointing arrow. To select a sentence, hold the Ctrl key and click on the sentence you wish to select. If you wish to select an entire paragraph, triple-click the mouse in the paragraph. To select a character to the right or the left of the insertion point, hold the Shift key and press the arrow keys to the right or the left.

If you wish to select a large amount of text, click an insertion point at the beginning of the text, move to the end of the text that you wish to select, and holding Shift, click at the end of the text. This is very helpful when you want to select text that fills more than one page.

Slide 26: Insert or Overtype
[image: insert overtype]
By default, Office applications are set to insert text into the document as the text is typed. If you forgot a word in the middle of a sentence, click an insertion point where the word is to begin and type it. The text will insert and the rest of the text will slide to the right as you type.

You may also have situations where the text that is in the document must be replaced with other text. Using the Overtype Mode replaces the text to the right as you type the new text. To change to the Overtype Mode, open the Office menu and select the Word Option button. Select the option Use Overtype Mode in the Editing section of the Advanced tab. When you have completed your changes using the Overtype Mode, repeat these directions to remove the setting from the Word Options.

There is also a keyboard selection that you can make to control whether you are in Insert or Overtype Mode. It is a toggle, meaning the first time it is pressed it has one setting and the next time it changes to the other. In order to use the Insert key, a selection must be made on the Word Options dialog box shown here. Select the option Use the Insert Key to Control Overtype Mode. This stays in effect until you change the setting in this dialog box.

Slide 27: Moving and Copying
[image: move copy]
At times, you will decide that text you have in one place in your document would be better in another. The Clipboard commands make it easy to move text. At other times, you might decide to have the same text in multiple places in the document. Again, the Clipboard commands will assist you in copying the text.

The three Clipboard commands are Cut, Copy and Paste. Begin by selecting the text that will be affected by a move or copying. The Cut command, with a scissors icon, removes the text from its original location and stores it in memory. The Copy command, with a two-paper icon, makes a duplicate of the text and places it in memory. Click on the Cut or Copy icon. Click an insertion point where you wish to place the text, and paste it by clicking on the Paste command. Only one item can be stored in memory at a time.

When the text is pasted into its new location, a Paste Options button appears with the pasted text. By clicking the down arrow, you can select the formatting option for the text you pasted.

There are alternative methods for copying, cutting and pasting. After you have selected the text, point to it with the mouse and right-click. Select Copy or Cut from the shortcut menu. Move to the new location for the text, click on an insertion point, right-click the mouse again and select Paste from the shortcut menu.

Keyboard commands can also be used to copy, cut and paste. Press the Ctrl key and C to copy text. Press the Ctrl key and X to cut the text. Press Ctrl and V to paste.

Another way to move text is to drag and drop it into the new location with the mouse. This works if you are moving the text short distances.

Slide 28: The Clipboard
[image: clipboard]
A nice feature of Office 2007 is the ability to store multiple clips of text on the Clipboard. This memory location stores up to 24 items to paste in the current file, another file, or in another Office 2007 software application. To add items to the Clipboard, you must display it by clicking the Dialog Box Launcher in the Clipboard group of the Home tab. The Clipboard pane opens and the Clipboard collects items that you either copy or cut from your document.

To paste an item, place an insertion point in the document, click the item in the Clipboard pane to display the down arrow and then select Paste.

You may also set the Clipboard so it accumulates text clips without the Clipboard pane open. Click the Option button in the Clipboard pane and select the Collect without Showing Office Clipboard option.

Slide 29: Find Command
[image: find command]
Finding a particular word or phrase in a lengthy document can be time-consuming and frustrating. Office has three commands that can assist you with finding text. The Editing group on the Home tab contains the Find and Replace commands. Type the word or phrase into the Find what text box and click the Find Next button. You can continue to work through the document using the Find Next button.

Slide 30: Find and Replace Command
[image: find replace command]
Another handy feature is the ability to replace text that is found with new text. Let’s say you used your co-worker’s name in a document multiple times. Over the weekend, she flies to Vegas and gets married. To change her name in the document, you would use the Replace option. You type the original text into the Find text box on the Find and Replace dialog box. Type the new text into the Replace with text box and select the Replace, Replace Next or Replace All button.

Slide 31: Go To Command
[image: go to command]
In a long document you will often need to move to a specific page. Perhaps your co-worker tells you that a paragraph on page 25 needs to be changed. You can jump to that page in the document by using the Go To command. Type the number of the page you wish to locate and click Next. Note the additional options shown in the Go To dialog box.

Slide 32: Undo and Repeat
[image: undo repeat]
As you edit your Office files, you may find that you make a mistake or change your mind. The Undo option cancels your previous action and can continue canceling back multiple steps. The Undo button is located on the Quick Access Toolbar. The down arrow next to the command will list your previous steps. By selecting one of the listed steps, you can undo all of your actions up to that point.

The Repeat command is more limited. It will only repeat the last action.

Slide 33: Language Tools
[image: language tools]
Office 2007 contains language tools which assist you in spelling, grammar and research. Spelling and grammar are checked automatically as you work on a document. If a word in your document does not appear in the Office dictionary, it is flagged by a red wavy line. Grammatical errors are highlighted with a green wavy line. Please realize that these are suggestions or flags alerting you to possible problems. Words that are flagged may actually be right, with some examples being company names and proper names. These types of words can be added to the dictionary if they are used frequently so that they do not show up as incorrect.

To fix spelling errors, right-click on the word with a red wavy line. A shortcut menu will display possible spellings for the word. You will also see options to Ignore the misspelling once, Ignore all instances of the misspelling in the document, or Add to Dictionary. Grammatical errors display a similar shortcut menu, prompting you with options to improve the sentence.

You may also ignore all errors until after you have completed your document and check the entire document at once. The Proofing group on the Review tab offers the option for Spelling and Grammar checking.

Note that this verification process should not be the only way your document is proofread. You still have to proofread it carefully. Office does not read the text in context, so if you spell an incorrect word in the context correctly, it will not mark it.

Another language tool that is available in Office is a Thesaurus. This tool will help you select different words for those you find you are using too often. Select a word in the document to look up in the Thesaurus and right-click it. Select Thesaurus from the shortcut menu. The Thesaurus pane will open, offering you suggestions for alternative words. You may select one of those words or look up additional options.

Slide 34: Research
[image: research]
As you work with Word, Excel or PowerPoint, you may need to complete some quick research. Tools for completing this research are located in the Review tab under the Research option. The Research pane allows you to specify where to search, and includes tools such as a dictionary, encyclopedia, or Internet sites for business and financial information. Enter a search term or keyword into the text box in the pane and click on the Go button. Do not forget that information that you find using the Research pane is copyrighted. Avoid the problem of plagiarism by citing all sources that you use.

Slide 35: Font Attributes
[image: font attributes]
To improve the look of your documents, you will want to make changes to the fonts. This increases the visual appeal and lets you draw attention to important parts of the document.

Text can be formatted with font attributes such as font face, size, emphasis, and color. The Font group on the Home tab provides the formatting options. You have the choice of selecting the options and then typing the text, or typing the text, selecting it, and applying the options. More than one attribute can be applied to text, so you may have Times Roman font face, in size 26 point, in bold and italic, and colored blue. As you look at the Font group, you can tell what attribute is selected because it has a gold background. If you do not want it to be applied to the text, click on the attribute to unselect it. 

Office 2007 features Live Preview of font attributes. Select the text, point to the attribute on the Font group, and the text in the document will change to reflect the attribute you are pointing to. This helps you to make your selection quickly.

Changing font attributes is such a common task in Office 2007 that there are numerous places for you to change the font. You can use the Font group on the Home tab, the Mini toolbar that appears when you select text, and the Font dialog box available by clicking on the Dialog Box Launcher. When using the dialog box, you will not have the benefit of Live Preview, but you may select multiple formatting options quickly. The preview will appear instead in the Preview box of the dialog box.

Slide 36: The Format Painter
[bookmark: _GoBack][image: format painter]
After you have formatted the text in one part of your document, you may want to use the same formatting in other parts of the document. Rather than remembering what each attribute was set to, you may use the Format Painter to “paint the format” onto the text.

First, select the formatted text. Second, click on the Format Painter in the Clipboard group of the Home Ribbon. If you single-click, the format will be applied to only one location, turning off after you have applied it. If you want to apply the format to multiple locations in the document, double-click the Format Painter command. Once the Format Painter has been loaded with the format, click and drag across the text you wish to format. If you double-clicked on the Format Painter, press the Esc key to turn the function off.
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